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With	the	Android	version	of	Lightroom,	Adobe	primarily	targets	an	enthusiastic	photography	audience.	The	slick	and	feature-heavy	interface	offers	nearly	all	photo-editing	tools	available	with	the	desktop	version.	Though	it	lacks	certain	workflow	features,	plug-in	capability,	and	printing,	Lightroom	is	still	a	pretty	good	choice.Edit,	organize	and	share
raw	files	with	ease.Using	Adobe	Photoshop	Lightroom	(Android),	editors	can	do	their	job	quickly,	and	easily.	Advanced	features	like	gesture	control	and	sync	control	make	Lightroom	a	better	choice	than	RawTherapee,	LightZone,	IrfanView,	and	other	competitors.A	range	of	advanced	featuresWhen	you	run	Lightroom,	you’ll	notice	a	grid	of	synced
images	with	expandable	toolbars.	While	Lightroom	works	perfectly	fine	on	an	Android	phone,	you	may	want	to	consider	simplifying	the	interface	on	a	tablet.	Thankfully,	gesture	control	gives	you	the	power	to	easily	declutter	the	screen.For	editing	raw	camera	images,	you	can	use	Adobe	Lightroom	‘Profiles’.	It’s	a	major	improvement	on	the	limited
options	for	raw	file	conversion	from	the	previous	version.	Additionally,	you	can	check	out	some	artistic	profiles	resembling	Instagram	filters.Lightroom	offers	a	‘Curves’	tool,	which	makes	tone	adjustment	a	breeze.	With	the	Android	version,	you	get	most	of	the	adjustments	for	color	and	lighting.	There’s	also	a	‘Crop’	tool	for	presetting	aspect	ratios	and
auto-straightening.	You	can	use	the	touch-input	mode,	and	leverage	advanced	features	like	the	healing	brush,	local	adjustment	brush,	and	gradient	and	linear	adjustments.Unlike	its	competitors,	the	AI-powered	object	search	allows	you	to	you	find	almost	anything	you	want.	You	can	import	images	from	a	folder	or	a	memory	card,	but	not	VSCO	images.
Lightroom	is	not	just	a	photo-editing	tool.	It	also	lets	you	organize	everything	by	keyword	tags	and	albums.	Only	LightZone	has	paid	more	attention	to	organizing	files	within	the	app.Lightroom	pretty	much	beats	every	other	competitor	with	face	recognition.	It’s	the	perfect	way	to	organize	your	photos.	Once	you’re	done	with	editing	or	organizing,
easily	share	the	final	output	to	Adobe’s	online	galleries	or	a	disk.Gesture	control	is	probably	the	most	amazing	feature	of	the	lot.	It	makes	everything	on	the	app	easier	and	faster	to	maneuver.	Additionally,	you	get	certain	areas	and	sliders	to	click,	which	can	be	double-tapped	to	view	new	displays	with	metadata.Using	Lightroom,	you	can	do	basic
enhancements,	while	leveraging	advanced	features	for	complex	workflows.	Apart	from	this,	you	can	crop	images.	On	the	downside,	it	is	not	possible	to	sync	all	the	adjustments	from	a	single	image	to	an	entire	batch.	It	is	an	area	where	apps	like	RawTherapee	win	over	Lightroom.Having	said	that,	Lightroom	(Android)	is	backed	by	Adobe,	which	has
always	been	the	go-to	brand	for	creative	apps.	Like	other	software	and	apps	available,	this	one	is	popular	worldwide,	thereby	providing	you	with	an	opportunity	to	learn	from	experts	around	the	world.With	Lightroom	(Android),	you	get	access	to	tutorials	from	experienced	photographers	and	influencers.	In	a	world	that’s	connected	on	every	social
media	platform,	it	gives	the	much-needed	exposure	to	your	creativity.Application	in	the	real-worldWhile	experienced	professionals	and	businesses	will	still	prefer	Adobe	Lightroom’s	desktop	version,	the	Android	app	has	been	increasingly	popular	among	individuals	and	freelancers.	Portrait	photographers,	wedding	photographers,	creative	designers
and	Instagram	influencers	not	only	need	an	editing	tool	but	a	comprehensive	organizer.Offering	the	best	of	both	worlds,	this	is	where	Adobe	Photoshop	Lightroom	beats	the	competition.	Moreover,	the	ability	to	sync	files	in	Adobe’s	galleries,	and	the	possibility	to	use	the	entire	Creative	Cloud	suite	make	Lightroom	(Android)	an	excellent	choice.You
can	edit	and	adjust	your	images	with	ease	on	your	phone	without	having	to	access	your	computer.	The	updated	version	of	Adobe	Photoshop	Lightroom	(Android)	brings	the	app	closer	to	the	powerful	desktop	version.Where	can	you	run	this	program?Adobe	Photoshop	Lightroom	is	available	for	Android,	Windows	and	iOS,	which	lets	you	sync	photos
cross-platform	with	ease.Is	there	a	better	alternative?Although	Adobe	Lightroom	is	available	for	free,	you	still	need	a	Creative	Cloud	account.	The	limited	free	storage	space	might	also	be	a	deterrent.	If	you’re	looking	for	a	few	alternatives,	here	are	some	good	options.One	of	the	most	popular	alternatives	to	Lightroom,	RawTherapee	offers	advanced
features	for	editing	photos.	Yet,	it	primarily	wins	over	Lightroom	with	amazing	batch	processing	speed.	An	open-source	platform,	it’s	an	excellent	choice	for	dealing	with	compressed	images	and	raw	files.IrfanView	combines	excellent	organization	features	with	an	amazing	editing	system.	While	using	Lightroom,	you	might	be	troubled	by	the	lack	of
cataloging	options.	There	is	no	way	to	edit	metadata.	IrfanView	offers	these	features,	and	more!	Overall,	it	is	a	great	alternative	to	Adobe’s	Lightroom.If	you’re	only	interested	in	organizing	photos,	LightZone	is	a	great	choice.	It	lets	you	organize	and	stack	filters	according	to	your	preferences.	Though	it	is	a	simple	editing	tool,	it	has	some	exceptional
raw	file	processing	features.	There	is	just	one	catch!A	fast,	powerful	and	clean	photo-editing	and	organizing	tool,	Adobe	Photoshop	Lightroom	is	a	quicker	platform	than	the	desktop	version.	While	it’s	an	excellent	tool	to	have	in	your	kitty,	Adobe’s	cloud	storage	is	expensive,	and	transition	for	existing	users	could	be	tricky.	Should	you	download	it?	Yes,
definitely!	Though	Lightroom	has	always	been	considered	a	powerful	platform,	the	Android	version	feels	like	a	breath	of	fresh	air.	With	a	cleaner	interface,	simpler	options,	and	comprehensive	online	storage,	editing	or	organizing	your	photos	will	be	easier,	faster,	and	more	efficient.	While	you	do	lose	a	few	features,	you	get	a	lot	more	in	return.	Adobe
Photoshop	is	the	reference	app	when	it	comes	to	image	editing	and	many	years	at	the	top	haven’t	dimmed	its	shine.	It’s	also	a	serious	app:	Photoshop	has	a	steep	learning	curve	and	will	take	practice,	often	over	many	years,	to	get	to	grips	with.	For	the	average	user	is	Photoshop	the	best	option	or	is	it	just	more	power	than	most	people	need?Hands-
down	the	best	all-round	image	editing	app	Adobe	Photoshop	is	a	powerhouse	of	an	app	and	has	had	many	years	on	the	market	to	refine	and	improve	its	features.	It’s	paid	off,	as	few	people	would	deny	that	Photoshop	is	the	app	of	reference	when	it	comes	to	image	editing.	It’s	never	been	considered	accessible	and	other	apps	have	sought	to	take
advantage	of	this	by	launching	competing	software	offering	specific	Photoshop	features	(and	the	occasional	app	trying	to	recreate	all	of	Photoshop’s	features.	As	a	result,	for	many	people,	the	question	is:	do	I	opt	for	Photoshop	or	do	I	save	effort	and	money	by	trying	out	one	of	the	many	alternatives?	One	thing	that	is	undeniable:	Photoshop	is	the
photo	editing	and	all-round	image	editing	app	par	excellence.	If	you	are	specifically	looking	to	edit	photos	or	you	regularly	need	to	carry	out	a	wide	variety	of	assorted	edits	to	images,	Photoshop	offers	exactly	the	features,	power,	and	control	you’ll	need.	Now,	harnessing	these	powerful	features	isn't	an	easy	task.	It	typically	takes	users	dozens	of
hours	to	learn	how	to	use	Photoshop	and	even	longer	to	learn	how	to	use	it	well.	Luckily,	people	have	been	having	a	similar	problem	for	decades,	so	modern	users	will	be	able	to	take	advantage	of	the	huge	quantity	of	user-generated	and	official	support	documents,	videos,	and	tutorials	that	have	grown	over	the	years.Bear	in	mind,	however,	that
Photoshop	has	been	updated	many	times	in	this	period	and	older	material	might	be	difficult	to	relate	to	if	you’re	using	a	recent	version	of	the	app.	If	you’re	not	an	enthusiastic	photo	editor	or	you	typically	use	a	smaller	number	of	editing	tools,	the	fact	that	Photoshop	takes	so	much	practice	and	is	so	intensive	on	your	computer’s	resources	(older	and
less	powerful	Macs	will	have	a	hard	time	keeping	up),	it	might	be	more	practical	to	look	towards	another	app	that	isn’t	quite	so	focussed	on	all-round	greatness.	It	will	be	easier	on	your	brain	and	your	computer.	Where	can	you	run	this	program?	This	version	of	Photoshop	runs	on	Mac,	version	10.12	or	later	(Sierra).	There	is	also	a	version	for
Windows.	Is	there	a	better	alternative?	In	terms	of	an	all-round	image	editing	app	or	photo	editor,	no:	Photoshop	is	the	best.	Users	should	bear	in	mind,	however,	that	not	everyone	needs	an	all-around	app	or	powerful	photo	editor.	If	you	think	that	your	needs	might	allow	more	flexibility,	check	out	Krita	or	Corel	Painter,	which	are	both	less	resource-
intensive,	have	a	shorter	learning	curve,	and	offer	more	specific	features	than	Photoshop.	If	you’re	looking	for	a	free	all-around	option,	try	GIMP.	It	might	meet	your	needs	but	isn’t	the	polished	hero	that	Photoshop	is.Ever	heard	the	expression	“With	great	power	comes	great	responsibility”?	It	might	have	originally	referred	to	politics	and	royalty,	but
it	also	describes	Photoshop	perfectly.	It	is	king	of	the	photo	editors	but	takes	serious	effort	(and	RAM)	to	use	properly.	Make	sure	that	you	really	need	Photoshop	before	jumping	in.	Should	you	download	it?	If	you	need	Photoshop	beyond	a	doubt,	then	it’s	a	definite	download.	Many	of	us	who	design	for	apps	will	have	Photoshop	CC	in	our	arsenal	of
tools,	and	if	you're	anything	like	me	you'll	constantly	be	on	the	lookout	for	ways	to	work	smarter.	Today,	I'd	like	to	share	a	few	of	the	workflow	tips	and	tricks	I've	learned	over	the	years.	Adobe	Comp	CC	can	be	used	as	a	way	to	quickly	get	started	on	a	project,	whether	it's	for	UX/UI	decisions,	design	or	something	else.	Once	you	begin	a	project	in
Adobe	Comp,	you	can	set	up	a	grid	system	and	start	easily	adding	design	content,	from	type	formatting	using	Typekit	fonts	to	imagery	and	graphics.	When	you're	done,	you	can	take	what	you	design	in	Adobe	Comp	CC	right	into	Photoshop	CC	and	continue	working	on	it	there.02.	Set	up	smarterIn	order	to	streamline	your	workflow,	the	first	place	you
should	look	is	your	set-up.	For	example,	it's	easy	to	alter	your	workspace	to	show	more	of	the	tools	and	panels	you	will	need.	Simply	choose	'Window	>	Workspace	>	Graphic	and	Web'.	This	not	only	adds	and	organises	the	panels	you	will	be	using	most	often,	but	also	reveals	the	drawing	tools	in	the	toolbar.There	are	also	some	preferences	you	can
take	advantage	of.	Go	to	'Photoshop	CC	>	Preferences'	or	'Edit	>	Preferences'	,	select	the	'Units	&	Rulers'	category,	and	set	the	ruler	units	to	pixels	(or	whatever	you	need)	for	all	new	documents,	no	matter	which	profile	(print,	web	etc.)	has	been	used	to	create	it.	Next,	go	to	'Preferences	>	Performance	>	History	&	Cache	>	Web	/	UI	Design'.	Here,
you	can	optimise	history	states	for	web	and	UI	design,	and	gear	cache	levels	towards	smaller	files	with	lots	of	layers.85	brilliant	Photoshop	tutorialsOne	last	time-saver.	With	no	documents	open	in	Photoshop,	press	the	T	key	to	select	the	Horizontal	Type	tool	in	the	Tools	panel.	Then,	go	into	the	Options	bar	and	change	the	font,	font	size,	and	so	on	–
those	formatting	settings	will	become	your	new	default	for	any	new	documents	going	forward.Ever	since	artboards	were	introduced	in	Photoshop,	designing	for	the	web	or	apps	has	got	easier.	Artboards	allow	you	to	design	for	several	different	device	sizes	and	orientations	in	the	same	document,	and	make	exporting	faster.	Here	are	a	few
tips:alt+click	any	'plus'	icon	that	appears	around	an	artboard	when	the	artboard	is	selected	to	duplicate	italt+drag	the	artboard	to	a	new	position	to	duplicate	itSelect	an	artboard	using	any	method	and	hit	ctrl+J	to	duplicate	itPress	alt	and	click	an	artboard	in	the	Layers	panel	to	fit	that	artboard	to	your	screenTo	collapse	all	artboards	at	once,
cmd+click	on	the	arrow	next	to	the	artboard	name	in	the	Layers	panelTo	quickly	export	artboards,	choose	'File	>	Export	>	Quick	Export	as	PNG'04.	Create	a	gridUsing	the	new	Guide	layout	command	you	can	easily	set	up	a	grid	based	on	your	needs	Most	of	us	design	to	a	grid	of	some	sort	when	working	in	Photoshop.	The	latest	versions	of	Photoshop
CC	make	it	easy	to	do	this.	With	a	document	open,	choose	'View	>	New	Guide	Layout'.	In	the	dialog	box	that	appears,	you	can	set	vertical	and/or	horizontal	guides	and	apply	that	grid	to	selected	artboards	or	all	the	artboards	in	a	document.05.	Reuse	custom	shapesTo	save	a	serious	amount	of	time,	you	can	save	custom	shapes	and	reuse	them	If	you
find	yourself	creating	certain	shapes	often,	you	can	easily	save	those	shapes	for	reuse.	Simply	draw	the	shape,	then	select	the	Path	Selection	tool	(black	arrow),	right-click	the	shape	and	choose	'Define	Custom	Shape'.	This	will	save	the	shape	with	the	rest	of	your	custom	shapes,	which	can	be	accessed	by	selecting	the	Custom	Shape	tool	(under	the
Rectangle	tool),	or	in	the	Shape	menu	under	the	Options	bar.	Anywhere	you	can	save	a	bit	of	time	in	your	workflow	is	gold,	and	selecting	is	one	of	those	areas	you	can	always	learn	more	shortcuts	for.	Here	are	a	few	to	remember:Using	the	Move	tool,	select	the	'Auto	Select	Layer'	option	(or	'Auto	Select	Group')	in	the	Options	bar.	This	makes	it	easy	to
click	on	content	in	an	artboard	and	select	the	layerAlternatively,	leave	Auto	Select	off	and	cmd+click	content	to	temporarily	turn	it	onUsing	the	Move	tool	and	with	'Auto	Select	Layer'	on,	shift+click	multiple	objects	to	select	all	of	themOn	an	artboard	you	can	auto-select	individual	objects	using	the	Move	tool:	with	that	layer	selected,	rightclick	on	the
content	and	choose	the	parent	group	(or	other)	in	the	menu	that	appearsIf	there	isn't	a	lot	of	layered	content,	drag	across	content	to	select	more	than	one	layer07.	Tackle	vector	drawingInstead	of	hunting	around	for	vector	properties,	you	can	edit	them	with	the	Properties	panel	When	designing	for	the	web	or	apps,	you	will	need	to	create	vector
artwork.	This	has	got	easier	with	every	new	version	of	Photoshop.	A	case	in	point	is	the	overhaul	of	the	Properties	panel	–	where	we	can	find	the	most	widely	used	features	when	it	comes	to	editing	vector	shapes	in	one	place.Here	are	a	few	simple	drawing	and	editing	tips:To	drag	a	shape	as	you	are	drawing,	press	the	Spacebar,	drag	the	shape,	then
release	the	Spacebar	and	continue	drawingTo	draw	from	the	centre,	press	alt	as	you	drawTo	constrain	the	proportions,	press	shift	as	you	drawIf	you	don't	want	shapes	to	snap	to	the	artboard	edges,	you	can	toggle	on	and	off	Snap	Bounds	('View	>	Snap	To	>	Artboard	Bounds')One	final	tip:	Before	drawing	vector	shapes,	ensure	the	'Snap	Vector	Tools
and	Transforms	To	Pixel	Grid'	option	is	selected	('Photoshop	CC	>	Preferences	>	Tools	or	Edit	>	Preferences	>	Tools').	This	ensures	your	vectors	have	crisp	edges.08.	Copy	shape	formattingWe	spend	a	fair	amount	of	time	formatting	our	designs.	To	save	time,	you	can	copy	formatting	from	one	shape	to	another.	In	the	Layers	panel,	right-click	a	shape
layer	and	choose	'Copy	Shape	Attributes'	to	copy	all	the	attributes	(stroke/fill).	Then	select	more	than	one	layer	or	layer	group	and	right-click,	choosing	'Paste	Shape	Attributes'.	It's	also	possible	to	select	a	shape	with	the	Path	Selection	tool	–	simply	right-click	on	the	shape,	and	choose	'Copy	Fill'	or	'Copy	Complete	Stroke'	to	copy	and	paste	one	or	the
other.	09.	Save	assets	in	CC	LibrariesIf	your	company	lets	you	use	them,	CC	libraries	are	a	no-brainer	for	saving	and	reusing	assets	and	formatting	CC	Libraries	makes	it	easy	to	save	formatting	and	assets	(graphics,	for	instance)	in	the	cloud,	which	you	can	then	apply	to	design	projects	later.	To	reuse	a	saved	graphic,	simply	drag	it	from	the	Libraries
panel	into	your	design.	The	content	is	linked	to	the	asset	in	the	Libraries	panel	(by	default,	but	it	can	be	embedded),	allowing	you	to	have	consistent,	shared	elements	like	a	header	in	a	series	of	Photoshop	files.	If	you	update	the	Library	asset,	the	asset	will	update	across	your	designs.	Linking	smart	objects	is	great	for	updating	content	across	multiple
projects	Linked	smart	objects	allow	you	to	place	a	source	file	across	PSDs	for	non-destructive	editing.	Along	with	CC	Libraries,	this	can	really	speed	up	your	workflow	and	usually	save	on	file	size.For	instance,	if	you	design	for	Retina	(HiDPI)	@1x,	the	content	will	eventually	need	to	be	scaled.	Your	original	image	content	will	need	to	be	@2x	or	@3x	in
size.	It	can	then	be	brought	in	as	a	smart	object	using	'File	>	Place	Linked'.	If	you	scale	the	design	or	export	using	methods	like	'File	>	Export	>	Export	As'	,	where	you	can	change	the	Sizes	(2x),	Photoshop	knows	to	use	the	original	image	data	from	the	smart	object.11.	Save	layer	stylesSaving	layer	styles	help	create	greater	consistency	We	apply
layer	styles	to	our	content	to	add	non-destructive	styling	like	shadows,	gradients	and	strokes.	That	means	we	most	likely	use	a	lot	of	the	same	styling	across	objects.	You	can	save	layer	styles	in	the	Styles	panel	to	enable	you	to	reapply	them	elsewhere.	It's	an	easy	way	to	maintain	a	consistent	appearance	and	save	time.First	apply	layer	styles	to	a	layer
or	group	(applying	layer	styles	to	a	group	is	a	fast	way	to	apply	the	same	styling	to	a	bunch	of	objects).	Then,	select	'Window	>	Styles	>	Create	New	Style'.	Give	the	style	a	name,	adjust	the	settings	and	click	OK.	The	style	you	created	will	now	be	available	in	the	Styles	panel.	12.	Filter	layersFiltering	your	layers	can	make	focused	editing	much	easier	If
you	have	a	lot	of	layers	in	your	web	or	app	design	files,	it	can	become	difficult	to	locate	content	in	the	Layers	panel.	Filtering	layers	is	a	great	way	to	focus	on	specific	layers.	You	can	filter	based	on	name,	effects	applied,	artboards,	and	a	lot	more.For	instance,	you	can	filter	the	list	to	see	all	your	buttons	by	name	('button').	When	you're	finished,	you
can	turn	off	filtering	by	toggling	the	red	button	at	the	top	of	the	Layers	panel,	revealing	all	the	layers	again.	13.	Copy	out	CSSCopy	CSS	from	content	directly	in	the	layers	panel	for	use	in	development	In	the	Layers	panel,	you	can	copy	CSS	that	Photoshop	generates	from	layer	content.	You	can	then	use	this	code	in	your	development	process.	Go	to	the
Layers	panel	and	select	a	layer	or	group,	right-click	one	of	the	layers	or	groups	and	choose	'Copy	CSS'.	You	can	then	paste	the	CSS	into	an	editor.14.	Export	assetsAll	the	export	options	you	need	when	using	the	Export	option	Being	able	to	export	assets	for	use	in	the	development	process	is	one	of	the	reasons	many	web	designers	use	an	application
like	Photoshop.	Here	are	a	few	fast	ways	to	export	assets:To	export	artboards	as	PNG,	choose	'File	>	Export	>	Quick	Export	As	PNG'.	If	you	want	to	choose	a	different	file	format,	you	can	choose	'File	>	Export	>	Export	As'To	change	the	'Quick	Export'	to	something	other	than	PNG,	open	'Photoshop	CC	>	Preferences	>	Export	or	Edit	>	Preferences	>
Export')	and	change	the	export	optionsTo	export	anything	as	a	PNG,	select	it	in	the	Layers	panel,	right-click	and	choose	'Quick	Export	As	PNG'To	export	anything,	select	it	in	the	Layers	panel,	right-click	and	choose	'Quick	Export	As	PNG'	or	'Export	As'.	There	you	can	also	choose	to	export	multiple	sizes	(@1x,	@2x,	@3x	etc.)15.	Preview	on	a
deviceQuick	preview	on	a	device	using	the	Adobe	Preview	CC	mobile	app	and	Device	Preview	panel	in	Photoshop	Using	the	Device	Preview	panel	in	Photoshop	and	the	Adobe	Preview	CC	mobile	app	on	a	device,	you	can	preview	your	Photoshop	designs	on	multiple	iOS	devices.	Changes	you	make	in	Photoshop	CC	are	even	displayed	in	Preview	CC	in
real	time,	as	you	make	them.	In	the	Device	Preview	panel,	you	can	connect	multiple	iOS	devices	to	Photoshop	using	USB	or	Wi-Fi,	as	long	as	they	have	the	Adobe	Preview	CC	mobile	app	installed.We	all	occasionally	get	stuck	in	our	ways	and	need	a	push	to	try	newer	features.	Photoshop	now	delivers	so	many	ways	to	save	time	when	designing	for	the
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